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1
Safety

Your printer and the recommended supplies have been designed and tested to meet
strict safety requirements. Attention to the following information ensures the continued
and safe operation of your Xerox printer.

Notices and Safety
Read the following instructions carefully before operating your printer. Refer to these
instructions to ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety
requirements. These include safety agency evaluation and certification, and compliance
with electromagnetic regulations and established environmental standards.

The safety and environment testing and performance of this product have been verified
using Xerox® materials only.

Note
Unauthorized alterations, which can include the addition of new functions or the
connection of external devices, can affect the product certification. Formore information,
contact your Xerox representative.
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Electrical Safety

General Guidelines

Warning

• Do not push objects into slots or openings on the printer. Touching a voltage point
or shorting out a part could result in fire or electric shock.

• Do not remove the covers or guards that are fastened with screws unless you are
installing optional equipment and are instructed to do so. Turn off the printer when
performing these installations. Disconnect the power cordwhen removing covers and
guards for installing optional equipment. Except for user-installable options, there
are no parts that you can maintain or service behind these covers.

Warning
The following are hazards to your safety:

• The power cord is damaged or frayed.
• Liquid is spilled into the printer.
• The printer is exposed to water.
• The printer emits smoke, or the surface is unusually hot.
• The printer emits unusual noise or odors.
• The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

Power Cord
• Use the power cord supplied with your printer.
• Do not use an extension cord or remove or modify the power cord plug.
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that

each end of the cord is connected securely. If you do not know if an outlet is grounded,
ask an electrician to check the outlet.

• Do not use a ground adapter plug to connect the printer to an electrical outlet that
does not have a ground connection terminal.

Warning
Avoid the potential of electrical shock by ensuring that the printer is grounded properly.
Electrical products can be hazardous if misused.

• Verify that the printer is plugged into an outlet that is providing the correct voltage
and power. Review the electrical specification of the printer with an electrician if
necessary.

• Do not place the printer in an area where people can step on the power cord.
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• Do not place objects on the power cord.
• If the power cord becomes frayed or worn, replace it.
• Do not plug or unplug the power cord while the power switch is in the On position.
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging

the power cord.
• Ensure that the electrical outlet is near the printer and is easily accessible.

The power cord is attached to the printer as a plug-in device on the back of the printer.
If it is necessary to disconnect all electrical power from the printer, disconnect the power
cord from the electrical outlet.

Emergency Power Off

If any of the following conditions occur, power the printer off immediately. Disconnect
the power cord from the electrical outlet. Contact an authorized Xerox service
representative to correct the problem if any of the following occurs:

• The equipment emits unusual odors or makes unusual noises.
• The power cable is damaged or frayed.
• A wall panel circuit breaker, fuse, or other safety device has been tripped.
• Liquid is spilled into the printer.
• The printer is exposed to water.
• Any part of the printer is damaged.

Laser Safety

This printer complies with laser product performance standards set by governmental,
national, and international agencies and is certified as a Class 1 Laser Product. The
printer does not emit hazardous light because the beam is enclosed completely during
all modes of customer operation and maintenance.

Laser Warning
Use of controls, adjustments, or performance of procedures other than those specified
in this manual can result in hazardous radiation exposure.

Operational Safety
Your printer and supplies were designed and tested to meet strict safety requirements.
These include safety agency examination, approval, and compliance with established
environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe
operation of your printer.

Operational Guidelines
• Do not remove any paper trays while the printer is printing.
• Do not open the doors when the printer is printing.
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• Do not move the printer when it is printing.
• Keep hands, hair, neckties, and so on, away from the exit and feed rollers.
• Covers, which require tools for removal, protect the hazard areas within the printer.

Do not remove the protective covers.

Hot Warning
The metallic surfaces in the fuser area are hot. Always use caution when removing
paper jams from this area and avoid touching any metallic surfaces.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced
depends on copy volume. Ozone is heavier than air and is not produced in amounts large
enough to harm anyone. Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to
www.xerox.com/environment. In other markets, contact your local Xerox representative
or go to www.xerox.com/environment_europe.

Printer Location
• Place the printer on a level, solid, non-vibrating surface with adequate strength to

hold its weigh. To find the weight for your printer configuration, refer to Physical
Specifications.

• Do not block or cover the slots or openings on the printer. These openings are provided
for ventilation and to prevent overheating of the printer.

• Place the printer in an areawhere there is adequate space for operation and servicing.
• Place the printer in a dust-free area.
• Do not store or operate the printer in an extremely hot, cold, or humid environment.
• Do not place the printer near a heat source.
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive

components.
• Do not place the printer where it is exposed directly to the cold air flow from an air

conditioning system.
• Do not place the printer in locations that are susceptible to vibrations.
• For optimum performance, use the printer at the elevations specified in Elevation.

Printer Supplies
• Use supplies that are designed for your printer. The use of unsuitable materials can

cause poor performance and a possible safety hazard.
• Follow all warnings and instructionsmarked on, or supplied with the product, options,

and supplies.
• Store all consumables in accordance with the instructions provided on the package

or container.
• Keep all consumables away from the reach of children.
• Never throw toner, print cartridges, drum cartridges, or toner containers into an open

flame.
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• When handling cartridges, such as toner cartridges, avoid skin or eye contact with
toner. Eye contact can cause irritation and inflammation. Do not attempt to
disassemble the cartridge, which can increase the risk of skin or eye contact.

Caution
Use of non-Xerox supplies is not recommended. The XeroxWarranty, Service Agreement,
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation
of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not
specified for this printer. The Total Satisfaction Guarantee is available in the United
States and Canada. Coverage could vary outside these areas. For details, contact your
Xerox representative.

Maintenance Safety
• Do not attempt to perform any maintenance procedure that is not described

specifically in the documentation supplied with your printer.
• Do not use aerosol cleaners. Clean with a dry lint-free cloth only.
• Do not burn any consumables or routine maintenance items.
• For information on Xerox supplies recycling programs, go to www.xerox.com/gwa.

Warning
Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used
on electromechanical equipment.

Printer Symbols

DescriptionSymbol

Warning:
Indicates a hazard that can cause serious injury or death
if not avoided.

Hot Warning:
Hot surface on or in the printer. Use caution to avoid per-
sonal injury.

Caution:
Indicates a mandatory action to take to avoid damage to
the property.

Do not touch the part or area of the printer.
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DescriptionSymbol

Do not expose the drum cartridges to direct sunlight.

Do not burn the toner cartridges.

Do not burn the drum cartridges.

Do not touch the part or area of the printer.

DescriptionSymbol

Do not use paper attached with staples or any other form
of binding clip.

Do not use folded, creased, curled, or wrinkled paper.

Do not load or use inkjet paper.

Do not use transparencies or overhead projector sheets.

Do not reload paper previously printed on or used.

Add paper or media.

Paper jam

Lock

Unlock
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DescriptionSymbol

Document

Paper

WLAN
Wireless Local Area Network

LAN
Local Area Network

USB
Universal Serial Bus

Postcard

Load envelopes in the tray with the flaps closed and facing
up.

Load envelopes in the tray with the flaps open and facing
up.

Weight

Data Transmission

Paper Feeding Direction Indicator

OK Button

Print Menu Button
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DescriptionSymbol

Online Button

DescriptionSymbol

Information Button

Menu Button

Back Button

Power/Wake Button

Cancel Job Button

Left Direction Indicator

Right Direction Indicator

Up Direction Indicator

Down Direction Indicator

WPS Button
(Wi-Fi Protected Setup)

This item can be recycled. For details, refer to Recycling and
Disposal.
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Environmental, Health, and Safety
Contact Information
Formore information on Environment, Health, and Safety in relation to this Xerox product
and supplies, contact the following customer help lines:

1-800-ASK-XEROX (1-800-275-9376)United States and Canada:

+44 1707 353 434Europe:

For product safety information in the United States, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe.
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2
Features

Parts of the Printer

Front View

6.1. Output Tray ExtensionPaper Level Indicator
2. 7.Optional Feeder Tray 2with 550-Sheet

Capacity
Card Reader Bay for optional NFC
Enablement Kit

8.3. Control Panel DisplayTray 1 with 250-Sheet Capacity
4. 9.Bypass Tray and Extension USB Port

10.5. Control Board CoverOutput Tray
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Rear View

5.1. Network Cable PortTray 1 Rear Access Cover
2. 6.Power Receptacle Duplex Unit

7.3. Rear DoorPower Switch
4. USB Cable Port

Internal Components

3.1. Toner CartridgeFront Cover
2. Drum Cartridge
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Control Panel

DescriptionNo.DescriptionNo.

Back Button: Used to go back one level
in the menu.

5WPS (Wi-Fi Protected Services) Button:
Used for wireless network connectivity.

1

OK Button: Confirms the selection on
the control panel display.

6Alphanumeric Keypad2

Cancel Button7Arrow Buttons: The up/down and
left/right arrows are used to scroll
through the options available in the
selected menu, as shown on the con-
trol panel display, and to increase and
decrease the values.

3

Power On/Off Button8Menu Button: Enters Menu Mode and
lets you access options and settings.

4
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Information Pages
Your printer has a set of information pages that you can access from the printer control
panel.

Accessing the Information Pages
1. At the printer control panel, press theMenu button. If necessary, allow a moment

for the machine to warm up.
2. Press theMenu button again.

A list of menu items appear.
3. Press the Up/Down arrow button, and select Information.
4. Press the Right arrow button.
5. Press the Up/Down arrow button, and select Information.

A list of Information pages appear.
6. Press the Up/Down arrow button, and select an information page to print.
7. To select an information page, press the Right arrow button, and then select the OK

button.

Configuration Report

The Configuration Report provides product information including installed options,
network settings, port setup, tray infromation, and more.

To print the Configuration Report, refer to the System Administrator Guide at
www.xerox.com/office/3330docs.
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Power Saver Mode
Power Savermode reduces power consumptionwhen the printer is left idle for a specified
period.

Power Saver Levels

There are two levels of Power Saver mode.

• Low Power Save: After a specified period of inactivity, the control panel display dims
and the printer operates on reduced power consumption.

• Very Low Power Save: After a specified period of inactivity, the control panel display
turns off and the printer enters standby mode.

Setting the Power Saver Mode Timers at the Control Panel

For details, refer to the System Administrator Guide at www.xerox.com/office/3330docs

Exiting Power Saver Mode

The printer exits Power Saver mode automatically when any of the following events
occur.

• You press a button on the control panel.
• The printer receives data from a connected device.
• You open any door or cover on the printer.
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Administration Features
For details, refer to the SystemAdministrator Guide at www.xerox.com/office/3330docs.

Xerox® CentreWare® Internet Services

Xerox® CentreWare® Internet Services is the administration and configuration software
installed on the embedded Web server in the printer. It allows you to configure and
administer the printer from a Web browser.

Xerox® CentreWare® Internet Services requires:

• A TCP/IP connection between the printer and the network in Windows, Macintosh,
UNIX, or Linux environments.

• TCP/IP and HTTP enabled in the printer.
• A network-connected computer with a Web browser that supports JavaScript.

Accessing Xerox®CentreWare® Internet Services
1. At your computer, open a Web browser.
2. In the address field, type the IP address of the printer.
3. Press Enter or Return.

Locating the IP Address of the Printer

To install print drivers for a network-connected printer, you need the IP address of your
printer. You also need the IP address to access and configure any printer settings in
Xerox® CentreWare® Internet Services.

You can view the IP address of your printer on the control panel display.
1. At the printer control panel, press theMenu button.
2. Press the Up/Down arrow button, and select Information.
3. Press the Right arrow button.
4. Press the Down arrow button, and select About this Printer.
5. Press the Right arrow button.
6. Press the Down arrow button, and select TCP/IPv4 Address.

The screen automatically scrolls right to left, showing the IP address.

Maintenance Assistant

Your printer includes a built-in diagnostic capability allowing you to send diagnostic
information directly to Xerox. Maintenance Assistant is a remote diagnostic tool that
offers a fast way to resolve potential issues, receive assistance, and automate the
troubleshooting or repair process.

Enabling Maintenance Assistant

Before you begin: If your network uses a proxy server, configure the Proxy Server settings
of the printer to ensure that the printer can connect to the Internet.
1. From the Printer Status window, clickHelp > Xerox® CentreWare® Internet Services.
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2. From Xerox® CentreWare® Internet Services, click Status > SMart eSolutions.
3. From Smart eSolutions, clickMaintenance Assistant.
4. To send status information to Xerox, click Start an Online Troubleshooting Session

at www.Xerox.com.
5. After the data is sent, your browser is redirected to www.xerox.com to start your

online troubleshooting session.
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More Information
You can obtain more information about your printer from these sources:

LocationResource

Packaged with the printer.Installation Guide

www.xerox.com/office/3330docsOther documentation for your printer

www.xerox.com/office/3330supportTechnical support information for your printer,
including online technical support, Online Sup-
port Assistant, and driver downloads.

Press the control panel Help (?) button.Information about menus or error messages

Print from the control panel, or from Xerox®

CentreWare® Internet Services, click Proper-
ties > Services > Printing > Reports.

Information Pages

From Xerox® CentreWare® Internet Services,
click Help.

Xerox® CentreWare® Internet Services docu-
mentation

www.xerox.com/office/3330suppliesOrder supplies for your printer

www.xerox.com/office/businessresourcecenterA resource for tools and information, including
interactive tutorials, printing templates, helpful
tips, and customized features to meet your in-
dividual needs.

www.xerox.com/office/worldcontactsLocal sales and support center

www.xerox.com/office/registerPrinter registration

www.direct.xerox.com/Xerox® Direct online store
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3
Installation and Setup

See also:

Installation Guide packaged with your printer.

System Administrator Guide at www.xerox.com/office/3330docs.

Installation and Setup Overview
Before printing, ensure that your computer and the printer are plugged in, turned on,
and connected. Configure the initial settings of the printer, then install the driver software
and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect to
a network using an Ethernet cable or wireless connection. Hardware and cabling
requirements vary for the different connectionmethods. Routers, network hubs, network
switches, modems, Ethernet cables, and USB cables are not included with your printer
andmust be purchased separately. Xerox recommends an Ethernet connection because,
typically, it is faster than aUSB connection, and it provides access to Xerox®CentreWare®

Internet Services.

Note
If the Software and Documentation disc is not available, you can download the latest
drivers from www.xerox.com/office/3330drivers.

Related Topics:

Selecting a Location for the Printer

Selecting a Connection Method

Connecting the Printer to the Network

Configuring Network Settings

Installing the Software
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Selecting a Location for the Printer
Note
Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room
can cause condensation inside the printer, directly interfering with image transfer.

• Select a dust-free area with temperatures from 10–30°C (50–90°F), and relative
humidity 20–80%

• Place the printer on a level, solid, non-vibrating surface with adequate strength for
the weight of the printer. The printer must be horizontal with all four feet in solid
contact with the surface. To find theweight for your printer configuration, see Physical
Specifications.

• Select a location with adequate clearance to access supplies and to provide proper
ventilation. To find the clearance requirements for your printer, see Clearance
Requirements for Standard Configuration.

• After positioning the printer, you are ready to connect it to the power source and
computer or network.

Connecting the Printer

Selecting a Connection Method

The printer can be connected to your computer using a USB cable or an Ethernet cable.
The method you select depends on how your computer is connected to the network. A
USB connection is a direct connection and is the easiest to set up. An Ethernet connection
is used for networking. If you are using a network connection, it is important to
understand how your computer is connected to the network. For details, refer to About
TCP/IP and IP Addresses.

Note

• Not all options listed are supported on all printers. Some options apply only to a
specific printer model, configuration, operating system, or driver type.

• Hardware and cabling requirements vary for the different connection methods.
Routers, network hubs, network switches, modems, Ethernet cables, and USB cables
are not included with your printer and must be purchased separately.

Network

If your computer is connected to an office network or home network, use an Ethernet
cable to connect the printer to a network port. Ethernet networks can support many
computers, printers, and devices simultaneously. In most cases, an Ethernet connection
is faster thanUSB and provides direct access to printer settings using Xerox®CentreWare®

Internet Services.
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Wireless Network

If your network includes a wireless router or wireless access point, you can connect the
printer to the network with awireless connection. Awireless network connection provides
the same access and services as a wired connection provides. A wireless network
connection is typically faster than USB and allows direct access to the printer settings
when using Xerox® CentreWare® Internet Services.

USB

If you connect the printer to one computer and do not have a network, use a USB
connection. A USB connection offers fast data speeds, but typically not as fast as an
Ethernet connection. In addition, a USB connection does not provide access to Xerox®

CentreWare® Internet Services.

Connecting the Printer to the Network

Use a Category 5 or higher Ethernet cable to connect the printer to the network. An
Ethernet network is used for one or more computers and supports many printers and
systems simultaneously. An Ethernet connection provides direct access to printer settings
using Xerox® CentreWare® Internet Services.

To connect the printer:
1. Connect the power cord to the printer, and plug the cord into an electrical outlet.
2. Connect one end of a Category 5 or higher Ethernet cable to the Ethernet port on

the printer. Connect the other end of the Ethernet cable to a correctly configured
network port on a hub or router.

3. Turn on the printer.
For details on configuring network settings, refer to the System Administrator Guide
at www.xerox.com/office/3330docs.

Connecting to a Computer Using USB

To connect using USB, you need Windows 7, Windows 8 or later, Windows Server 2008
or later, or Macintosh OS X version 10.9 or later.

To connect the printer to the computer using a USB cable:
1. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the left side

of the printer.
2. Connect the A end of the USB cable to the USB port on the computer.
3. If the Windows Found New Hardware Wizard appears, select Cancel.
4. Install the print drivers. For details, refer to Installing the Software.

Turning On/Off the Printer

Before turning on the printer, ensure that the power cord is plugged into the printer and
wall outlet, and that the the power switch is in the off position.
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The printer has a power Down button on the control panel display and a power switch
on the back-left side.

• The power down button on the control panel display initiates an orderly shutdown
of the printer electronic components.

• The power switch on the side of the printer controls the main power to the printer.

1. To turn on the printer, press the power switch to the On position.

If the power switch is on, but the printer is powered off, the printer was turned off
using the control panel. To switch on the printer, press the power switch to the Off
position and then to the On position.

2. To turn off the printer:

Caution

• To prevent a printer malfunction, perform the control panel shutdown first.
• Do not plug or unplug the power cord while the printer is powered on.

a) At the printer control panel, press the Power Saver button.
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b) Touch Power Down.

Note
When all of the control panel lights are off, the printer power-off sequence is
complete. Turning the power switch off is optional.
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Configuring Network Settings

About TCP/IP and IP Addresses

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet
network. Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to
communicate with a network printer. For Macintosh OS X systems, TCP/IP is preferred.
Unlike TCP/IP, however, Bonjour does not require printers or computers to have IP
addresses.

With TCP/IP protocols, each printer and computer must have a unique IP address. Many
networks and cable andDSL routers have aDynamic Host Configuration Protocol (DHCP)
server. A DHCP server automatically assigns an IP address to every computer and printer
on the network that is configured to use DHCP.

If you use a cable or DSL router, for information on IP addressing, refer to the
documentation for your router.

Installing the Software
Before you install driver software, verify that the printer is plugged in, turned on,
connected correctly, and has a valid IP address. If you cannot find the IP address, see
Locating the IP Address of the Printer.

If the Software and Documentation disc is not available, download the latest drivers
from www.xerox.com/office/3330drivers.

Operating System Requirements

Windows Vista, Windows 7, Windows 8, Windows Server2008, WindowsServer2008 R2,
and Windows Server 2012.

• Macintosh OS X version 10.9 and later
• UNIX and Linux: Your printer supports connection to various UNIX platforms through

the network interface. For details, see www.xerox.com/office/3330drivers.
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Installing Drivers and Utilities for Windows

To access all the features of your printer, install the Xerox® print driver and the Xerox®

scan driver.

To install the print and scan driver software:
1. Insert the Software and Documentation disc into the appropriate drive on your

computer. The installer starts automatically.

If the installer does not start automatically, navigate to the drive, and double-click
the Setup.exe installer file.

2. To change the language, click Language.
3. Select your language, then click OK.
4. Click Install Drivers > Install Print and Scan Drivers.
5. To accept the license agreement, click I Agree.
6. From the list of discovered printers, select your printer, then click Next.
7. If your printer does not appear in the list of discovered printers, click Extended Search.
8. If your printer still does not appear in the list of discovered printers, and you know

the IP address:
a) Click the Network Printer icon at the top of the window.
b) Enter the IP address or the DNS name of the printer.
c) Click Search.
d) From the list of discovered printers, select your printer, then click Next.

9. If the printer still does not appear in the list of discovered printers, and you do not
know the IP address:
a) Click Advanced Search.
b) If you know the gateway address and subnet mask, click the top button and

enter the addresses into the Gateway and Subnet Mask fields.
c) If you know the address of another printer on the same subnet, click the middle

button and enter the address in the IP Address field.
d) Click Search.
e) From the list of discovered printers, select your printer, then click Next.

Note
When the printer appears in theDiscovered Printers window, it displays the IP address.
Record the IP address for future use.

10. Select the desired driver.
11. Click Install.
12. If the installer prompts you for the IP address, enter the IP address of the printer.
13. If the installer prompts you to restart your computer, click Restart to complete the

installation of the drivers.
14. To complete the installation, click Finish.

Installing Print Drivers for Macintosh OS X Version 10.9 and Later

Install the Xerox print driver to access all features of your printer.
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To install the print driver software:
1. Insert the Software and Documentation disc into the appropriate drive on your

computer.
2. To view the .dmg file for your printer, double-click the disc icon.
3. Open the .dmg file, then navigate to the appropriate installer file for your operating

system.
4. To begin installation, open the Installer package file.
5. To acknowledge the warning and introductory messages, click Continue. Click

Continue again.
6. To accept the license agreement, click Continue, then click Agree.
7. To accept the current installation location, click Install, or select another location for

the installation files, then click Install.
8. Enter your password, then click Install Software.
9. Select your printer in the list of discovered printers, then click Continue. If your printer

does not appear in the list of discovered printers:
a) Click the Network Printer icon.
b) Type the IP address of your printer, then click Continue.
c) Select your printer in the list of discovered printers, then click Continue.

10. To accept the print queue message, click Continue.
11. To accept the installation success message, click Close.
12. To verify that the print driver recognizes the installed options:

a) From the Apple menu, click System Preferences > Printers and Scanners.
b) Select the printer from the list, then click Options & Supplies.
c) Click Options.
d) Confirm that all of the options installed on the printer appear correct.
e) If you change settings, clickOK, close the window, then exit System Preferences.
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Installing the Print Drivers for UNIX and Linux

To install the UNIX print drivers on your computer, root or superuser privileges are
required.

This procedure requires an Internet connection.

To install Linux drivers, perform the following steps, then select Linux instead of UNIX
for the operating system and package.

To install the print driver software:
1. At the printer, verify that the TCP/IP protocol is enabled and the network cable is

installed.
2. At the printer control panel, for the IP address, do the following:

a) Allow the printer to set up a DHCP address.
b) Print the configuration page and keep it for reference.

3. At your computer, do the following:
a) From the print driver website for your printer, select your printer model.
b) From the Operating System menu, select UNIX, then click Go.
c) Select the appropriate package for your operating system.
d) To begin downloading, click the Start button.

4. In the notes below the driver package that you selected, click the Installation Guide
link, then follow the installation instructions.

Other Drivers

The following drivers are available for download at www.xerox.com/office/3330drivers.

• The Xerox®Global Print Driver works with any printer on your network, including those
printers made by other manufacturers. It configures itself for your individual printer
at installation.

• The Xerox® Mobile Express Driver works with any printer available that supports
standard PostScript. It configures itself for the printer you select every time you print.
If you travel frequently to the same sites, you can save your favorite printers in that
location and the driver saves your settings.

Installing the Printer as a Web Service on
Devices
Web Services on Devices (WSD) allow a client to discover and access a remote device
and its associated services across a network. WSD supports device discovery, control,
and use.

Installing a WSD Printer Using the Add Device Wizard
1. At your computer, click Start, then select Devices and Printers.
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2. To launch the Add Device Wizard, click Add a Device.
3. In the list of available devices, select the one you want to use, then click Next.

Note
If the printer you want to use does not appear in the list, click the Cancel button. Add
theWSD printer manually using the Add Printer Wizard; for details, refer to Installing
a WSD Printer Manually Using the Add Printer Wizard.

4. Click Close.

Installing a WSD Printer Manually Using the Add Printer Wizard
1. At your computer, click Start, then select Devices and Printers.
2. To launch the Add Printer Wizard, click Add a Printer.
3. Click Add a network, wireless, or Bluetooth printer.
4. In the list of available devices, select the one you want to use, then click Next.
5. If the printer that you want does not appear in the list, click The printer that I want

is not listed.
6. Select Add a printer using a TCP/IP address or hostname, then click Next.
7. For the Device type field, selectWeb Services Device.
8. In the Hostname or IP address field, enter the printer IP address. Click Next.
9. Select an option for sharing the printer with others in your network.
10. To identify the printer for sharing, enter a share name, location, and comments to

identify the printer. Click Next.
11. To set the printer as the default, select an option. To test the connection, click Print

a Test Page.
12. Click Finish.

AirPrint, Mopria, Google Cloud Print, and
NFC
The following allow you to print without requiring a print driver:

AirPrint

Use AirPrint to print from awired or wireless device directly without using a print driver.
AirPrint is a software feature that allows you to print from wired or wireless Apple
iOS-basedmobile devices andMacOS-based devices without the need to install a print
driver. AirPrint-enabled printers allow you to print or fax directly from aMac, an iPhone,
iPad, or iPod touch.

Mopria

Mopria is a software feature that enables users to print from mobile devices without
requiring a print driver. You can use Mopria to print from your mobile device to
Mopria-enabled printers.
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Google Cloud Print

Google Cloud Print allows you to print documents from an Internet-connected device
without using a print driver. Documents stored in the cloud, a personal computer, tablet,
or smartphone can be sent to the printer from anywhere.

NFC (Near Field Communication)

Near field communication (NFC) is a technology that enables devices to communicate
when they are within 10 centimeters of each other. You can use NFC to obtain the
network interface to establish a TCP/IP connection between your device and the printer.

For more information, refer to the System Administrator Guide:

• www.xerox.com/office/WC3335docs
• www.xerox.com/office/WC3345docs
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4
Paper and Media

Supported Paper
Your printer is designed to use various paper and other media types. To ensure the best
print quality and to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Ordering Paper

To order paper or other media, contact your local reseller or visit
www.xerox.com/office/3330supplies.

General Paper Loading Guidelines
• Fan paper before loading it in the paper tray.
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the

tray.
• Adjust the paper guides to fit the paper size.
• If excessive jams occur, use paper or other approved media from a new package.
• Do not print on label media after a label has been removed from a sheet.
• Use only paper envelopes.
• Print envelopes 1-sided only.

Paper That Can Damage Your Printer

Some paper and othermedia types can cause poor output quality, increased paper jams,
or damage your printer. Do not use the following:

• Rough or porous paper
• Inkjet paper
• Non-laser glossy or coated paper
• Paper that has been photocopied
• Paper that has been folded or wrinkled
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• Paper with cutouts or perforations
• Stapled paper
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips
• Padded envelopes
• Plastic media

Caution
The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does
not cover damage caused by using unsupported paper or specialty media. The Xerox®

Total Satisfaction Guarantee is available in the United States and Canada. Coverage
could vary outside these areas. For details, please contact your local Xerox representative.

Paper Storage Guidelines

Storing paper and other media properly contributes to optimum print quality.

• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage
from ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs,
is particularly damaging to paper.

• Reduce the exposure of paper to strong lights for long periods of time.
• Maintain constant temperatures and relative humidity.
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces aremore

likely to collect moisture.
• Store paper flat, either on pallets, cartons, shelves, or in cabinets.
• Avoid food or drinks in the area where paper is stored or handled.
• Do not open sealed packages of paper until you are ready to load the paper into the

printer. Leave stored paper in the original packaging. The paper wrapper protects the
paper from moisture loss or gain.

• Some specialmedia is packaged inside resealable plastic bags. Store themedia inside
the bag until you are ready to use it. Keep unused media in the bag and reseal it for
protection.

Supported Paper Types and Weights

WeightsPaper TypesTrays

70–85 g/m2

70–85 g/m2

70–85 g/m2

70–85 g/m2

60–70 g/m2

85–105 g/m2

106–163 g/m2

105–120 g/m2

60–85 g/m2

Not Applicable

Plain
Letterhead
Pre-printed
Hole-Punched
Lightweight
Heavyweight
Cardstock
Bond
Recycled
Archival

Bypass and
Trays 1 and 2

Not ApplicableTransparencyBypass Tray and Tray
1 only
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WeightsPaper TypesTrays

120–150 g/m2

75–90 g/m2

60–220 g/m2

Labels
Envelope
Custom

Bypass Tray only

Supported Standard Paper Sizes

North American Standard SizesEuropean Standard SizesTray

Letter (216 x 279 mm, 8.5 x 11 in.)
Legal (216 x 356 mm, 8.5 x 14 in.)
Oficio (216 x 343 mm, 8.5 x 13.5 in.)
Folio (216 x 330 mm, 8.5 x 13 in.)
Executive (184 x 267 mm, 7.25 x
10.5 in.)
Statement (140 x 216 mm, 5.5 x
8.5 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)
A5 (148 x 210 mm, 5.8 x 8.3 in.)
JIS B5 (182 x 257 mm, 7.2 x
10.1 in.)
ISO B5 (176 x 250 mm, 6.9 x
9.8 in.)
A6 (105 x 148 mm, 4.1 x 5.8 in.)

Bypass and Trays 1
and 2

Postcard (102 x 152 mm, 4 x 6 in.)
No. 10 envelope (241 x 105 mm, 4.1
x 9.5 in.)
No. 9 envelope (114 x 162 mm, 4.5 x
6.38 in.)
Monarch envelope (98 x 190 mm, 3.9
x 7.5 in.)
Index Card (76.2 x 127 mm, 3 x 5 in.)

C5 envelope (162 x 229 mm, 6.4 x
9 in.)
C6 envelope (114 x 162 mm, 4.5 x
6.38 in.)
DL envelope (110 x 220 mm, 4.33
x 8.66 in.)
Index Card (76.2 x 127 mm, 3 x
5 in.)
Postcard (100 x 148 mm, 3.94 x
5.83 in.)

Bypass Tray only

Supported Custom Paper Sizes

LengthWidthTray

148–356 mm (5.8–14 in.)98–216 mm (3.9–8.5 in.)Bypass Tray

148–356 mm (5.8–14 in.)105–216 mm (4.1–8.5 in.)Trays 1 and 2

Supported Paper Types andWeights for Automatic 2-Sided Printing

WeightsPaper Types

60–70 g/m2Lightweight

60–85 g/m2Recycled

70–85 g/m2Plain
Letterhead
Hole-Punched
Pre-printed
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WeightsPaper Types

86–105 g/m2Heavyweight

105–120 g/m2Bond

Supported Standard Paper Sizes for Automatic 2-Sided Printing

North American Standard SizesEuropean Standard Sizes

Letter (216 x 279 mm, 8.5 x 11 in.)
Legal (216 x 356 mm, 8.5 x 14 in.)
Oficio (216 x 343 mm, 8.5 x 13.5 in.)
Folio (216 x 330 mm, 8.5 x 13 in.)
Executive (184 x 267 mm, 7.25 x 10.5 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)
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Supported Custom Paper Sizes for Automatic 2-Sided Printing

ThicknessSizesMedia TypesSource

60–163 g (16–43 lb.)A4, Letter, Legal, Execut-
ive, Folio, Oficio, ISO B5,
JIS B5, A5, A6

Plain, Lightweight,
Heavyweight, Bond,
Cardstock, Recycled,
Archive

Tray 1 or 2

60~220 g.(16–58 lb.)A4, Letter, Legal, Execut-
ive, Folio, Oficio, ISO B5,
JIS B5, A5, A6, 3"x5"

Plain, Lightweight,
Heavyweight, Bond,
Cardstock, Cotton,
Colored, Pre-Printed, Re-
cycled, Archive, Transpar-
ency, Label

Bypass
Tray

Monarch, No.10, DL, C5,
C6

Envelope

International Post CardCardstock

Odd size: min 75 mm
width x 125 mm length

Custom

60~120 g (16–32 lb.)A4, Letter, Legal, Folio,
Oficio

Plain, Lightweight,
Heavyweight, Bond, Re-
cycled

Duplex
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Loading Paper

Loading Paper in the Bypass Tray

To load paper in the bypass tray:
1. Open the bypass tray.

If the bypass tray is loaded with paper already, remove any paper that is a different
size or type.

2. Move the width guides to the edges of the tray.
3. Flex the sheets back and forth and fan them, then align the edges of the stack on a

level surface. This procedure separates any sheets that are stuck together and reduces
the possibility of jams.

Note
To avoid jams and misfeeds, do not remove paper from its packaging until you are
ready to use it.

Xerox® Phaser® 3330 Printer4-6
User Guide

Paper and Media



4. Load the paper in the tray, and adjust the width guides until they touch the edges
of the paper.

• Load hole-punched paper with the holes toward the left side of the printer.
• For 1-sided and 2-sided printing, to load letterhead or pre-printed paper, place

letterhead face up with the top edge going into the printer first.

Note
Do not load paper above the maximum fill line. Overfilling the tray can cause the
printer to jam.

5. If the control panel Paper Settings screen prompts you, verify the paper size, type,
and color.

6. When finished, touch Confirm.
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Loading Paper in Tray 1 and Optional Tray 2
Note
The following procedure applies to both tray 1 or tray 2.

1. Pull out the tray.

• For tray 1, pull out and remove the tray.

• For tray 2, remove the tray by pulling it out until it stops, lifting the front of the
tray slightly, and then pulling it out.
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2. Move the length and width guides out:

a) Pinch the guide lever on each guide.
b) Slide the guides outward until they stop.
c) Release the levers.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a
level surface. This procedure separates any sheets that are stuck together and reduces
the possibility of jams.
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4. Load the paper into the tray, and adjust the paper guides in the tray to match the
size of the paper.

• Load paper into the tray with the print side face down.
• Load hole-punched paper with the holes toward the right of the printer.
• Do not load paper above themaximum fill line. Overfilling can cause paper jams.

5. Slide the tray into the printer and push it in all the way.
6. If the control panel Paper Settings screen prompts you, verify the paper size, type,

and color.
7. When finished, touch Confirm.

Setting Paper Size and Type
After loading paper in the paper tray, set the paper size and type using the control panel.
For computer printing, select the paper size and type in the application program you
use on your computer.

Note
The settings made from the printer driver on your computer override the settings on the
control panel.

After closing the paper tray, the Paper Size and Type settings are automatically displayed.
If correct, use the settings displayed or use the following procedures to change the
settings for the the size and type of paper loaded.

Setting the Paper Size
1. PressMenu on the control panel.
2. Press the Up/Down arrow buttons, and select Tray Paper Settings.
3. Press the Right arrow button.
4. Press the Up/Down arrow buttons, and select the required tray.
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5. Press the Right arrow button.
6. Press the OK button to accept current setup, or press the Down arrow button to

change the setup.
7. Press the Right arrow button.
8. With Paper Size selected, press the Right arrow button.
9. Press the Up/Down arrow buttons, select the paper size.
10. Press the OK button to save changes.

If you want to use special sized paper, select a custom paper size in the Printer Driver.

Setting the Paper Type
1. PressMenu on the control panel.
2. Press the Up/Down arrow buttons, and select Tray Paper Settings.
3. Press the Right arrow button.
4. Press the Up/Down arrow buttons, and select the required tray.
5. Press the Right arrow button.
6. Press the OK button to accept current setup, or press the Down arrow button to

change the setup.
7. Press the Right arrow button.
8. Press the Up/Down arrow buttons, and select Paper Type.
9. Press the Right arrow button.
10. Press the Up/Down arrow buttons, and select the paper type.
11. Press the OK button to save changes.
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Printing on Special Paper
To order paper, transparencies, or other media, contact your local reseller or go to
www.xerox.com/office/3330supplies.

Envelopes
Note
You can ONLY print envelopes from the bypass tray. For details, see Supported Standard
Paper Sizes.

Guidelines for Printing Envelopes
• Print quality depends on the quality and construction of the envelopes. Try another

envelope brand if you do not get desired results.
• Maintain constant temperatures and relative humidity.
• Store unused envelopes in their packaging to avoid excess moisture and dryness

which can affect print quality and cause wrinkling. Excessive moisture can cause the
envelopes to seal before or during printing.

• Before loading envelopes into the tray, remove air bubbles by setting a heavy book
on top of them.

• In the print driver software, select Envelope as the paper type.
• Do not use padded envelopes. Use envelopes that lie flat on a surface.
• Do not use envelopes with heat-activated glue.
• Do not use envelopes with press-and-seal flaps.
• Use only paper envelopes.
• Do not use envelopes with windows or metal clasps.

Loading Envelopes in the Bypass Tray
1. Open the bypass tray.

2. Move the width guides to the edges of the tray.
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If you do not load envelopes in the bypass tray right after they have been removed
from the packaging, they can bulge. Flatten them to avoid jams.

3. To load envelopes, place the envelopes with the print side up, flaps closed and down,
and the flap of the envelope to the left.

4. Adjust the guides until they touch the edges of the paper.
5. If the control panel Paper Settings screen prompts you, verify the paper size, type,

and color.
6. When finished, touch Confirm.
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Labels
Note
You can print labels only from the Bypass Tray.

Guidelines for Printing Labels

Caution
Do not use any sheet where labels are missing, curled, or pulled away from the backing
sheet. It could damage the printer.

• Use labels designed for laser printing.
• Do not use vinyl labels.
• Do not feed a sheet of labels through the printer more than once.
• Do not use dry gum labels.
• Print only on one side of the sheet of labels. Use full sheet labels only.
• Store unused labels flat in their original packaging. Leave the sheets of labels inside

the original packaging until ready to use. Return any unused sheets of labels to the
original packaging and reseal it.

• Do not store labels in extremely dry or humid conditions or extremely hot or cold
conditions. Storing them in extreme conditions can cause print-quality problems or
cause them to jam in the printer.

• Rotate stock frequently. Long periods of storage in extreme conditions can cause
labels to curl and jam in the printer.

• In the print driver software, select Label as the paper type.
• Before loading labels, remove all other paper from the bypass tray.

Loading Labels in the Bypass Tray

To load labels in the bypass tray:
1. Open the bypass tray.

2. Move the width guides to the edges of the tray.
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3. Load the labels face up.

4. Adjust the guides until they touch the edges of the paper.
5. If the control panel prompts you, verify the paper size, type, and color in the Paper

Settings screen.
6. When finished, touch Confirm.

Transparencies
Note
You can print transparencies from either the Bypass tray or from Tray 1.

Guidelines for Printing Transparencies

Remove all paper before loading transparencies in the tray.

• Handle transparencies by the edges using both hands. Fingerprints or creases can
cause poor print quality.

• After loading transparencies, change the paper type to Transparency on the printer
control panel.

• In the print driver software, for paper type, select Transparency.
• Do not loadmore than 20 transparencies. Overloading the tray can cause the printer

to jam.
• Do not fan transparencies.
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5
Printing

Printing Overview
Before printing, your computer and the printer must be plugged in, turned on, and
connected to an active network.Make sure that you have the correct print driver software
installed on your computer. For details, see Installing the Software.
1. Select the appropriate paper.
2. Load paper in the appropriate tray.
3. At the printer control panel, specify the size and type.
4. In your software application, access the print settings. Formost software applications,

press CTRL > P for Windows or CMD > P for Macintosh.
5. Select your printer.
6. To access the print driver settings for Windows, select Properties or Preferences. For

Macintosh select Xerox® Features.
7. Select the desired options.
8. To send the job to the printer, click Print.

Related Topics:

Loading Paper

Selecting Printing Options

Printing on Both Sides of the Paper

Printing on Special Paper

Selecting Printing Options
Printing options, also called print driver software options, are specified as Printing
Preferences in Windows, and Xerox® Features in Macintosh. Printing options include
settings for 2-sided printing, page layout, and print quality. You can choose default
settings for various printing options; formore information refer to SettingDefault Printing
Options forWindows and Selecting PrintingOptions forMacintosh. Printing options that
you set from within the software application are temporary and are not saved.
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Print Driver Help

Xerox® print driver software Help is available from the Printing Preferences window. To
see print driver help, click the Help (?) button in the bottom left corner of the Printing
Preferences window.

Information about Printing Preferences appears in the Help window on two tabs:

• Contents provides a list of the driver tabs at the top and the areas at the bottom of
the Printing Preferences window. To find explanations for each of the driver fields
and areas, in the Printing Preferences window, click the Contents tab.

• Search provides a field where you can enter the topic or function for which you need
information.

Windows Printing Options
Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings
specified in the Printing Preferences window. You can specify yourmost common printing
options and save them so that you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, in Printing
Preferences, specify 2-sided printing.

To select default printing options:
1. On your computer, navigate to the list of printers:

a) ForWindows Vista, click Start > Control Panel > Hardware and Sound > Printers.
b) For Windows 7, click Start > Devices and Printers.
c) For Windows 8, click Control Panel > Devices and Printers.

Note
If the Control Panel icon does not appear on the desktop, right-click on the
desktop, then select Personalize > Control Panel Home > Devices and Printers.
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2. In the list, right-click the icon for your printer and click Printing Preferences.
3. In the Printing Preferences window, click a tab, select the options, then click OK to

save.

For more information aboutWindows print driver options, in the Printing Preferences
window, click the Help button (?).

Selecting Windows Print Options for an Individual Job

To use special printing options for a particular job, you can change the Printing
Preferences before sending the job to the printer. For example, if you want the highest
print quality when you print a document, in Printing Preferences, select Enhanced, then
submit the print job.
1. With the document open in your software application, access the print settings. For

most software applications, click File > Print or press CTRL > P.
2. To open the Properties window, select your printer, then click the Properties or

Preferences button. The title of the button varies depending on your application.
3. In the Properties window, click a tab, then make selections.
4. To save your selections and close the Properties window, click OK.
5. To send the job to the printer, click OK.

Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print
jobs.

To save a set of printing options:
1. With the document open in your application, click File > Print.
2. Select the printer, then click Properties.
3. In the Properties window, select the desired settings for each tab.
4. To save the settings, click the arrow to the right of the Saved Settings field at the

bottom of the window, then click Save As.
5. Type a name for the set of printing options, then to save the set of options in the

Saved Settings list, clickOK.
6. To print using these options, select the name from the list.

Macintosh Printing Options
Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File > Print.
2. Select your printer.
3. Select Xerox® Features.
4. Select the desired options.
5. Click Print.
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Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print
jobs.

To save a set of printing options:
1. With the document open in your application, click File > Print.
2. In the printer list, select your printer.
3. Select the desired printing options.
4. To save the settings, select Save Current Settings as Preset.

Linux Printing Options
Launching Xerox® Printer Manager
To launch Xerox® Printer Manager from a command line prompt:
1. Login in as root.
2. Type xeroxprtmgr.
3. Press Enter or Return.

Printing from a Linux Workstation

The Xerox® print driver accepts a job ticket setting file that contains preset printing
features. You can also submit print requests through the command line using lp/lpr. For
more information about Linux printing, click theHelp (?) button in the Xerox® print driver.
1. Create a print queue. To set up a queue, refer to the System Administrator Guide at

www.xerox.com/office/3330docs.
2. With the desired document or graphic open in your application, open the Print dialog

box.
For most software applications, click File > Print or press CTRL > P.

3. Select the target print queue.
4. Close the Print dialog box.
5. In the Xerox® print driver, select the available printer features.
6. Click Print.
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Creating a Job Ticket Using the Xerox Print Driver
1. In a command line prompt, open the Xerox® print driver, login as root, and type

xeroxprtmgr.
2. On the My Printers screen, select the printer.
3. In the top corner, click Edit Printer, then select options for the print job.
4. Click Save As, then store the job ticket in your home directory.

Personally identifiable information, such as a Secure Print passcode, is not saved in
the job ticket. You can specify the information on the command line.

To print using the job ticket, type the command lp -d{Target_Queue} -
oJT=<path_to_ticket> <file_name>.

The following commands are examples of how to print using a job ticket:

lp -d{Target_Queue} -oJT={Absolute_Path_To_Job_Ticket}
{Path_To_Print_File}

lp -dMyQueue -oJT=/tmp/DuplexedLetterhead /home/user/PrintReadyFile

lp -dMyQueue -oJT=/tmp/Secure -oSecurePasscode=1234
/home/user/PrintReadyFile

Printing Features
Printing on Both Sides of the Paper

Paper Types for Automatic 2-Sided Printing

The printer can print a 2-sided document automatically on supported paper. Before
printing a 2-sided document, verify that the paper type and weight are supported. For
details, see Supported Paper Types and Weights for Automatic 2-Sided Printing.

Printing a 2-Sided Document

Options for Automatic 2-Sided Printing are specified in the print driver. The print driver
uses the settings for portrait or landscape orientation from the application for printing
the document.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed
pages turn. These settings override the application page-orientation settings.

LandscapePortrait
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LandscapePortrait

2-Sided Print, Flip on
Short Edge

2-Sided Print2-Sided Print, Flip on
Short Edge

2-Sided Print

Selecting Paper Options for Printing

There are two ways to select the paper for your print job:

• Let the printer automatically select which paper to use based on the document size,
paper type, and paper color you specify.

• Select a specific tray loaded with the desired paper.

Printing Multiple Pages to a Single Sheet

Whenprinting amultiple-page document, you can printmore than one page
on a single sheet of paper.
1. On the Page Layout tab, select Pages Per Sheet.
2. Select 1, 2, 4, 6, 9, or 16 pages per side.

Page Layout is on the Document Options tab.

Scaling

Scaling reduces or enlarges the original document to match the selected output paper
size. InWindows, the Scale Options are located in the print driver on the PrintingOptions
tab in the Paper field.

To access Scale Options, click the arrow at the right side of the Paper field, select Other
Size, then select Advanced Paper Size.

• No Scaling: This option does not change the size of the page image printed on the
output paper, and 100% appears in the percentage box. If the original size is larger
than the output size, the page image is cropped. If the original size is smaller than
the output size, extra space appears around the page image.

• Automatically Scale: This option scales the document to fit the selected Output
Paper Size. The scaling amount appears in the percentage box below the sample
image.

• Manually Scale: This option scales the document by the amount entered in the
percentage box below the preview image.

Print Quality

Print-quality modes:

• Standard print-quality mode: 600 x 600 dpi (dots per inch)
• Enhanced print-quality mode: 600 x 600 x 5 dpi (1200 x 1200 enhanced image

quality)
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Note
The print resolutions are indicated for PostScript print drivers only. The only print-quality
mode for PCL is Enhanced.

Printing from a USB Flash Drive
You can print .pdf, .ps, .pcl, .prn, .tiff, and .xps files directly from a USB Flash drive.

Note
If USB ports are disabled, you cannot use aUSB card reader for authentication, to update
the software, or to print from a USB Flash drive.

The system administrator must set up this feature before you can use it. For details,
refer to the System Administrator Guide at www.xerox.com/office/3330docs.

To print from a USB Flash drive:
1. Insert your USB Flash drive in a USB port on the printer.

The Print from USB choice is highlighted on the control panel display.
2. Press the Right arrow button.
3. To scroll through the list and locate the printable file, use theUp/Down arrow buttons.
4. With the file you want to print highlighted, press the OK button.
5. Select the number of copies, and press the OKOK button.
6. Highlight the tray selection and press the OK button.
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6
Maintenance

Cleaning the Printer

General Precautions

Caution
When cleaning your printer do not use organic or strong chemical solvents or aerosol
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials
only as directed in this documentation.

Warning
Keep all cleaning materials out of the reach of children.

Warning
Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays
contain explosive mixtures and are not suitable for use in electrical applications. Use of
pressurized spray cleaners increases the risk of fire and explosion.

Caution
Do not remove the covers or guards that are fastened with screws. You cannot maintain
or service any parts that are behind these covers and guards. Do not attempt any
maintenance procedure that is not described in the documentation supplied with your
printer.

Warning
Internal parts of the printer can be hot. Use caution when doors and covers are open.

• Do not place anything on top of the printer.
• Do not open covers and doors during printing.
• Do not tilt the printer while it is in use.
• Do not touch the electrical contacts or gears. Doing so could damage the printer and

cause the print quality to deteriorate.
• Ensure that any parts removed during cleaning are replaced before you plug in the

printer.
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Cleaning the Exterior

Clean the exterior of the printer once a month.

Caution
Do not spray detergent directly on the printer. Liquid detergent could enter the printer
through a gap and cause problems. Never use cleaning agents other than water or mild
detergent.

1. Wipe the paper tray, output tray, control panel, and other parts with a damp, soft
cloth.

2. After cleaning, wipe with a dry, soft cloth.

Note
For stubborn stains, apply a small amount of mild detergent to the cloth and gently
wipe the stain off.

Ordering Supplies

When to Order Supplies

A warning appears on the control panel display when the Toner Cartridge or the Drum
Cartridge are near their replacement time. Verify that you have replacements on hand.
It is important to order these itemswhen themessages first appear to avoid interruptions
to your printing. An error message appears on the control panel display when the Toner
Cartridge or the Drum Cartridge must be replaced.

Order supplies from your local reseller or go to www.xerox.com/office/3330supplies.

Caution
Use of non-Xerox supplies is not recommended. The XeroxWarranty, Service Agreement,
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation
of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not
specified for this printer. The Total Satisfaction Guarantee is available in the United
States and Canada. Coverage could vary outside these areas. Please contact your Xerox
representative for details.

Viewing Printer Supply Status

You can check the status and percentage of life remaining for your printer supplies at
any time using the control panel.
1. At the printer, press theMenu button.
2. Using the Down arrow button, select Information.
3. Press the Right arrow button.
4. Using the Down arrow button, select Supplies Info. Press the Right arrow button.

A list of Supplies information appears. Using theUp/Down arrow buttons, select your
choice to view status.
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Consumables

Consumables are printer supplies that get depleted during the operation of the printer.
The consumable supplies for this printer is the genuine Xerox® Black Toner Cartridge
and the Xerox® Smart Kit Drum Cartridge.

Note

• Each consumable includes installation instructions.
• To ensure print quality, the toner cartridge and drum cartridge are designed to cease

functioning at a predetermined point.

Caution
Use of non-Xerox supplies is not recommended. Use of toner with other than genuine
Xerox® Toner can affect print quality and printer reliability. Xerox® Toner is the only
toner designed andmanufactured under strict quality controls by Xerox for use with this
specific printer.

Routine Maintenance Items

Routinemaintenance items are printer parts that have a limited life and require periodic
replacement. Replacements can be parts or kits. Routinemaintenance items are typically
customer replaceable.

Note
Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

• Standard Capacity Toner Cartridge
• High Capacity Toner Cartridge
• Extra High-Capacity Toner Cartridge
• Drum Cartridge

Note
Not all options listed are supported on all printers. Some options apply only to specific
printer models or configurations.
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Toner Cartridges
General Precautions for the Toner Cartridge

Warning

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills,
avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

• Keep toner cartridges out of the reach of children. If a child accidentally swallows
toner, have the child spit out the toner, and rinse the mouth with water. Consult a
physician immediately.

• Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove
spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you
spill a large volume of toner, contact your local Xerox representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge
can catch fire and cause burn injuries or an explosion.

Replacing a Toner Cartridge

When a toner cartridge approaches the end of its usable life span, the control panel
displays a toner low message. When a toner cartridge is empty, the printer stops and
displays a message on the control panel.

Note
Each toner cartridge includes installation instructions.

Cause and SolutionPrinter Status Message

The toner cartridge is low. Order a new toner
cartridge.

Low Toner Status. Ensure that a new Toner
Cartridge is available.

The toner cartridge is empty. Open the side
door and then the front cover, then replace the
toner cartridge.

Replace Toner Cartridge

Drum Cartridges
General Precautions for the Drum Cartridge

Caution
Donot expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting.
Do not touch or scratch the surface of the drum.

Caution
Do not leave the covers and doors open for any length of time, especially in well-lit
places. Light exposure can damage the drum cartridge.

Warning
Never throw a drum cartridge into an open flame. The cartridge can catch fire and cause
burn injuries or an explosion.
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Replacing a Drum Cartridge

When a drum cartridge approaches the end of its usable life span, the control panel
displays a drum cartridge low message. When a drum cartridge is empty, the printer
stops and displays a message on the control panel.

Note
Each drum cartridge includes installation instructions.

Cause and SolutionPrinter Status Message

The drum cartridge is low. Order a new drum
cartridge.

Image Unit Low Status. Ensure that a new
Drum Cartridge is available.

The drum cartridgemust be replaced. Open the
front cover, then replace the drum cartridge.

No message but the printer stops printing.

Recycling Supplies

For more information on the Xerox® supplies recycling program, go to:
www.xerox.com/gwa.

Moving the Printer

Warning
To prevent electric shock, never touch the power plug with wet hands. When removing
the power cord, ensure that you pull the plug and not the cord. Pulling the cord can
damage it, which can lead to fire or electric shock.

Warning
When moving the printer, do not tilt it more than 10 degrees to the front, back, left, or
right. Tilting the printer more than 10 degrees can cause toner spillage.

Warning
If the optional 550-sheet feeder is installed, uninstall it before you move the printer. If
the optional 550-sheet feeder is not fixed to the printer securely, it can fall to the ground
and cause injury.

Follow these instructions when moving the printer:
1. Turn off the printer and wait for the printer to shut down. For details, see Turning

On/Off the Printer.
2. Remove any paper or other media from the output tray.
3. When moving the printer from one location to another, use caution to ensure that

the printer does not topple.

6-5Xerox® Phaser® 3330 Printer
User Guide

Maintenance

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+3330&PgName=recyclesupplies&Language=English


4. Lift and carry the printer as shown in the illustration.

• To prevent dropping or tipping the printer, hold the printer with one hand
underneath to hold the printer and the other hand on top to stabilize it.

• Repack the printer and its options using the original packing material and boxes
or a Xerox Repackaging Kit. For a repacking kit and instructions, go to
www.xerox.com/office/3330support.

• When moving the printer over a long distance, remove the toner cartridges and
drum cartridges to prevent toner from spilling.

Caution
Failure to repackage the printer properly for shipment can result in damage not
covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee.
The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not
cover damage to the printer caused by improper moving.

5. After moving the printer:
a) Reinstall any parts you removed.
b) Reconnect the printer to the cables and power cord.
c) Plug in and turn on the printer.

Billing and Usage Counters Information
Billing and printer usage information appears on the Billing Meters information screen
at the control panel display. The impression counts shown are used for billing.

To view Billing and Usage information:
1. At the printer control panel, press theMenu button.
2. Press the Down arrow button to select Information.
3. Press theRight arrowbutton, then use theDown arrowbutton to selectBillingMeters.
4. Press the Right arrow button to view a list of information types.
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7
Troubleshooting

General Troubleshooting
This section contains procedures to help you locate and resolve problems. Resolve some
problems by simply restarting the printer.

Restarting the Printer

To restart the printer:
1. Press the Power button.
2. Press the Down arrow button, and select Power Down on the control panel display.
3. Press the OK button.

The printer powers down.
4. After one minute, press the Power button.

The printer begins initializing, and then reports that it is ready to print. A Configuration
Report prints.

Printer Fails to Power On

SolutionsProbable Causes

Turn on the power switch.The power switch is not turned on.

Turn off the printer power switch, and plug
the power cord securely into the outlet.

The power cord is not correctly plugged into the
outlet.

Plug another electrical appliance into the
outlet and see if it operates properly.
Try a different outlet.

Something is wrong with the outlet connected to
the printer.

Use a power sourcewithin the specifications
for the printer.

The printer is connected to an outlet with a voltage
or frequency that does not match the printer spe-
cifications.
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Caution
Plug the three-wire cord with grounding prong directly into a grounded AC outlet.

Related Topics:

Electrical Specifications

Printer Resets or Turns Off Frequently

SolutionsProbable Causes

Turn off the printer, confirm that the power
cord is plugged in correctly to the printer and
the outlet, then turn on the printer.

The power cord is not plugged into the outlet
correctly.

Turn off the printer, then turn it on again. Print
the Error Messages report from the
Troubleshooting Pages menu. If the error per-
sists, contact your Xerox representative.

A system error occurred.

Turn off the printer, then connect the power
cord to a suitable outlet.

The printer is connected to an uninterruptible
power supply.

Plug the printer directly into the outlet or into
a power strip that is not sharedwith other high-
power devices.

The printer is connected to a power strip shared
with other high-power devices.

Document Prints fromWrong Tray

SolutionsProbable Causes

1. Check the tray selected in the print driver.
2. 2. Go to the page setup or printer settings

of the application from which you are
printing.

3. 3. Set the paper source to match the tray
selected in the print driver or set the paper
source to Automatically Select.

Application and print driver have conflicting
tray selections.

Automatic 2-Sided Printing Problems

SolutionsProbable Causes

Ensure that you are using a supported paper
size and weight for 2-sided printing. Envelopes
and labels cannot be used for 2-sided printing.
For details, see Supported Types and Weights
for Automatic 2-Sided Printing and Supported
Standard Paper Sizes for Automatic 2-Sided
Printing.

Unsupported or incorrect paper
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SolutionsProbable Causes

In the print driver Properties, select 2-Sided
Print on the Paper/Output tab.

Incorrect setting

Paper Tray Fails to Close

SolutionProbable Cause

Some debris or an object is blocking the tray.The paper tray does not close fully.

Printing Takes Too Long

SolutionsProbable Causes

It takes more time to print on certain types of
special paper. Ensure that the paper type is set
properly in the driver and at the printer control
panel.

The printer is set to a slower printingmode. For
example, the printer could be set to print on
Heavyweight paper.

It takes time for printing to start when the
printer is exiting of Power Saver mode.

The printer is in Power Saver mode.

Determine if a print spooler or a computer
sharing the printer is buffering all print jobs and
then spooling them to the printer. Spooling can
slow print speeds. To test the speed of the
printer, print some information pages such as
the Office Demo Page. If the page prints at the
rated speed of the printer, you could have a
network or printer installation issue. For addi-
tional help, contact the system administrator.

The way the printer was installed on the net-
work could be an issue.

Wait. No action needed.The job is complex.

Change the print-quality mode in the print
driver to Standard.

The print-quality mode in the driver is set to
Enhanced.

Printer Fails to Print

SolutionsProbable Causes

To clear the error, follow the onscreen prompts.
If the error persists, contact your Xerox representative.

The printer has an error.

Load paper into the tray.The printer is out of paper.

Replace the empty toner cartridge.A toner cartridge is empty.
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SolutionsProbable Causes

Turn off the printer, confirm that the power cord is plugged in
correctly to the printer and the outlet, then turn on the printer.
For details, see Turning On/Off the Printer. If the error persists,
contact your Xerox representative.

The power cord is not correctly
plugged into the outlet.

• A previous print job could be the problem. On your computer,
you can use the printer properties to delete all print jobs in
the print queue.

• Load the paper in the tray.
• At the printer control panel, press the Job Status button. If

the print job does not appear check the Ethernet connection
between the printer and the computer.

• At the printer control panel, press the Job Status button. If
the print job does not appear, check the USB connection
between the printer and the computer. Turn off the printer,
then turn it on again.

The printer is busy.

• At the printer control panel, press the Job Status button. If
the print job does not appear check the Ethernet connection
between the printer and the computer.

• At the printer control panel, press the Job Status button. If
the print job does not appear, check the USB connection
between the printer and the computer. Turn off the printer,
then turn it on again.

The printer cable is disconnec-
ted.

Printer Makes Unusual Noises

SolutionsProbable Causes

Turn off the printer and then remove the ob-
struction or debris. If you cannot remove it,
contact your Xerox representative.

There is an obstruction or debris inside the
printer.
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Condensation has Formed Inside the Printer

Moisture can condense inside a printer where the humidity is above 85%or when a cold
printer is located in a warm room. Condensation can form in a printer after it has been
sitting in a cold room that is heated quickly.

SolutionsProbable Causes

• Allow the printer to acclimate for several
hours before operation.

• Allow the printer to operate for several hours
at room temperature.

The printer has been sitting in a cold room.

• Reduce the humidity in the room.
• Move the printer to a location where the

temperature and relative humidity are
within the operating specifications.

The relative humidity of the room is too high.

Paper Jams

Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox supported
paper. Other paper types can cause jams. If supported paper is jamming frequently in
one area, clean that area of the paper path.

The following can cause paper jams:

• Selecting the incorrect paper type in the print driver.
• Using damaged paper.
• Using unsupported paper.
• Loading paper incorrectly.
• Overfilling the tray.
• Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

• Use only supported paper. For details, see Supported Paper on page 48.
• Follow proper paper handling and loading techniques.
• Always use clean, undamaged paper.
• Avoid paper that is curled, torn, moist, creased, or folded.
• To separate the sheets before loading into the tray, fan the paper.
• Observe the paper tray fill line; never overfill the tray.
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• Adjust the paper guides in all trays after inserting the paper. A guide that is not
properly adjusted can cause poor print quality, misfeeds, skewed prints, and printer
damage.

• After loading the trays, select the correct paper type and size on the control panel.
• When printing, select the correct type and size in the print driver.
• Store paper in a dry location.
• Use only Xerox paper and transparencies designed for the printer.

Avoid the following:

• Polyester coated paper that is specially designed for inkjet printers.
• Paper that is folded, wrinkled, or excessively curled.
• Loading more than one type, size, or weight of paper in a tray at the same time.
• Overfilling the trays.
• Allowing the output tray to overfill.

Locating Paper Jams

Warning
To avoid injury, never touch a labeled area on or near the heat roller in the fuser. If a
sheet of paper is wrapped around the heat roller, do not try to remove it immediately.
Switch off the printer immediately and wait 30 minutes for the fuser to cool. After the
printer cools, try to remove the jammed paper. If the error persists, contact your Xerox
representative.

The following illustration shows where paper jams can occur along the paper path:
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1. Bypass Tray and Inside the Printer
2. Back of the Printer
3. Duplex Unit
4. Tray 1
5. Tray 2
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Clearing Paper Jams
Clearing Paper Jams from the Bypass Tray
Note
To resolve the error displayed on the control panel you must clear all paper from the
paper path.

1. Remove any paper from the bypass tray.Where the tray connects to the printer, clear
any paper that is jammed.

2. If the paper is torn, check inside the printer for pieces of paper, then gently remove
them. If you cannot remove the paper fragments easily, contact your Xerox
representative.

Warning
The area around the fuser can be hot. Use caution to avoid injury.

3. When you reload the bypass tray, fan the paper and ensure that all four corners align
neatly.

4. If the control panel prompts you, verify the size and type and press the OK button.
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Clearing Paper Jams from Tray 1
Note
To resolve the error displayed on the control panel you must removing any remaining
paper from the paper path.

1. Open Tray 1, then pull the tray out and completely away from the printer.

2. Remove crumpled paper from the tray and any remaining paper jammed in the
printer.
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3. Carefully reinsert and close the tray.

4. If the control panel prompts you, verify the paper size, type, and click theOK button..
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Clearing Paper Jams from Tray 2
Note
To resolve the error displayed on the control panel you must removing any remaining
paper from the paper path.

1. Open Tray 2, and slide it completely out and away from the printer.

2. Remove any crumpled paper from the tray and any remaining paper jammed in the
printer.

• If the paper does not move when you pull it or if you do not see the paper in this
area, stop and go to the Step 3.

• If the paper is removed, go to Step 4.

3. Perform the following steps to locate the jam.
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a) Open Tray 1.

b) Pull the paper straight up and out.
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c) Close Tray 1.

d) Look for any remaining crumpled paper in Tray 2 and remove it.

4. Close the Tray 2.

5. If the control panel display prompts you, verify the paper size, type, and press the
OK button.
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Clearing Paper Jams from Inside the Front Cover

To resolve the error displayed on the control panel you must clear all paper from the
paper path.
1. To access jammed paper inside the printer, open the front cover.

2. Remove any crumpled paper.

• If the paper does not move when you pull it or if you do not see the paper in this
area, stop and go to the Step 3.

• If the paper is removed, go to Step 6.
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3. Pull out the toner cartridge.

4. Gently remove any paper from inside the printer.
5. Reinstall the toner cartridge and push it into the printer.

Tabs on the sides of the cartridge and corresponding grooves within the printer will
guide the cartridge into the correct position until it locks into place.
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6. Close the front cover.

7. If prompted, follow the instructions on the control panel display to continue printing.

Clearing Paper Jams from the Back of the Printer
Note
To resolve the error displayed on the control panel you must clear all paper from the
paper path.

1. Pull down the rear cover.
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2. Push down the levers as shown.

3. To access the fuser area, push down on both sets of levers as shown, and pull down
the rollers.

4. Gently remove any jammed paper.
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Warning
The area around the fuser may be hot. Use caution to avoid any injury.

5. Return both sets of levers to their original positions.

6. Close the rear cover.
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7. If prompted, follow the instructions on the control panel display to continue printing.

Clearing Paper Jams from the Duplex Unit
Note
To resolve the error displayed on the control panel you must clear all paper from the
paper path.

1. To access paper jams in the duplex area, perform the following:
a) Remove the tray 1 rear cover.

b) Remove the duplex unit from the printer.

2. Gently remove any paper from the duplex area.
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If the paper does not come out with the duplex unit, go to the next step.

3. Insert the duplex unit back into the printer, aligning the edges of the unit with the
feed grooves on the inside of the printer.
a) Ensure that the duplex unit is fully pushed in.

b) Replace the tray 1 rear cover.

4. If prompted, follow the instructions on the control panel display to continue printing.
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Clearing Paper Jams from the Output Area
Note
To resolve the error displayed on the control panel you must clear all paper from the
paper path.

1. Gently pull out the paper from the output area.

If you do not see the jammed paper or if there is any resistance when you pull, stop
and go to Clearing Paper Jams from the Back of the Printer.

2. If prompted, follow the instructions on the control panel display to continue printing.

Troubleshooting Paper Jams
Multiple Sheets Pulled Together

SolutionsProbable Causes

Remove some of the paper. Do not load paper
past the MAX line.

The paper tray is too full.

Remove the paper, align the edges, and then
reload it.

The edges of the paper are not even.

Remove the paper from the tray, and replace
it with new dry paper.

The paper is moist from humidity.

Try a new ream of paper.
Do not fan transparencies before loading in
tray.

Too much static electricity is present.

Use only Xerox approved paper. For details,
refer to Supported Paper.

Using unsupported paper.

Feed paper one sheet at a time.Humidity is too high for coated paper.
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Paper Misfeeds

SolutionsProbable Causes

• Remove the misfed paper and reposition it
properly in the tray.

• Adjust the paper guides in the tray tomatch
the size of the paper.

The paper is not correctly positioned in the tray.

Remove some of the paper. Do not load paper
past the fill line.

The paper tray is too full.

Adjust the paper guides in the tray to match
the size of the paper.

The paper guides are not correctly adjusted to
the paper size.

Do not reuse the paper. Remove the paper, and
load the tray with new paper.

The tray contains warped or wrinkled paper.

Remove the moist paper and replace it with
new, dry paper.

The paper is moist from humidity.

Use only Xerox approved paper. For details, see
Supported Paper.

Using paper of the wrong size, thickness, or
type.

Label and Envelope Misfeeds

SolutionsProbable Causes

Do not use any sheet where labels are missing,
curled, or pulled away from the backing sheet.

Labels are missing, curled, or are pulling away
from the backing sheet.

• Load label sheets according to the instruc-
tions from the manufacturer.

• Load labels print side up in the bypass tray.
• Do not load labels in the high-capacity

feeder.

The label sheet is facing the wrong way in the
tray.

• Load envelopes in the bypass tray with the
print side up, flaps closed, and the short
edge leading into the printer.

• Ensure that the width guides rest loosely
against the edge of the envelopes without
restricting their movement.

Envelopes are loaded incorrectly in the bypass
tray.

The heat and pressure of the laser printing
process can cause wrinkling. Use supported
envelopes. For details refer to Guidelines for
Printing Envelopes.

Envelopes are wrinkling.
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Paper Jam Message Stays On

SolutionsProbable Causes

Recheck the paper path. Ensure that you have
removed all of the jammed paper.

Some paper remains jammed in the printer.

Check the doors on the printer. Close any door
that is open.

One of the printer doors is open.

Note
Check for any torn pieces of paper in the paper path, then remove the paper.

Jams During Automatic 2-Sided Printing

SolutionsProbable Causes

• Use only Xerox approved paper. For details,
see Supported Paper Types andWeights for
Automatic 2-Sided Printing and Supported
Standard Paper Sizes for Automatic 2-Sided
Printing.

• For automatic 2-sided printing, do not use
transparencies, envelopes, labels, reused
paper, or paper heavier than 105 g/m².

Using paper of the wrong size, thickness, or
type.

Load paper in the correct tray. For details, see
Supported Paper.

Paper is loaded in the wrong tray.

Load the tray with only one type and size of
paper.

Tray is loaded with mixed paper.

Print-Quality Problems
Your printer is designed to produce consistently high-quality prints. If you observe
print-quality problems, use the information in this section to troubleshoot the problem.
For more information, go to www.xerox.com/office/3330support.

Caution
The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does
not cover damage caused by using unsupported paper or specialty media. The Xerox
Total Satisfaction Guarantee is available in the United States and Canada. Coverage
could vary outside these areas. Please contact your local representative for details.

Note
To ensure consistent print quality, the toner cartridges and imaging units for many
models of equipment are designed to cease functioning at a predetermined point.
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Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and
optimum print quality, use paper designed for your printer and set the paper type
correctly. Follow the guidelines in this section to maintain optimum print quality from
your printer.

Temperature and humidity affect the quality of the printed output. The guaranteed
range for optimal print quality is 10–30ºC (50–90ºF) and 20–80% relative humidity.

Solving Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table and
see the corresponding solution to correct the problem. You can also print a Demo Page
to more precisely determine the print-quality problem.

If the print quality does not improve after carrying out the appropriate action, contact
your Xerox representative.

Note
To maintain print quality, the toner cartridge is designed to provide a warning message
when the toner level is low. When the toner cartridge reaches this level, a warning
message appears. Once the toner cartridge is empty, another message prompts you to
replace the toner cartridge. The printer stops printing until you install a new toner
cartridge.

SolutionsSymptom

• To check the toner level, check the control panel, use the
print driver, or XeroxSM CentreWareSM Internet Services. If
the toner cartridge is near empty, replace it.

• Verify that the toner cartridge is approved for use in this
printer, and replace it as needed. For best results, use a
genuine Xerox toner cartridge.

• Ensure that the print qualitymode is not set to Toner Saver.
Toner Saver us useful for draft quality output.

• Replace the paperwith a recommended size and type, and
confirm that your printer and print driver settings are cor-
rect.

• Verify that the paper is dry and that supported paper is
used. If not, change the paper.

• Change the Paper Type settings in the print driver.
• In the Printing Preferences of the print driver, on the Pa-

per/Output tab, change the Paper Type setting.
• If printer is located in a high altitude environment, adjust

the altitude setting of the printer. For details, see the Sys-
tem Administrator Guide at www.xerox.com/of-
fice/3330docs.

The output is too light.
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SolutionsSymptom

• Change the Paper Type settings in the print driver. For ex-
ample, change Plain to Lightweight Cardstock.

• In the Printing Preferences of the print driver, on the Pa-
per/Output tab, change the Paper Type setting.

• Verify that the paper is the correct size, type, and weight.
If not, change the paper settings.

• Verify that the printer is plugged into an outlet that is
providing the correct voltage and power. Review the elec-
trical specification of the printer with an electrician if ne-
cessary.

• For details, refer to Electrical Specifications.

Toner smears or print comes off.
The output has stains on the
back side.

• Ensure that the toner cartridge is installed correctly.
• If you used a non-genuine brand toner cartridge, install a

genuine Xerox toner cartridge.
• Use the Heavyweight or Cardstock paper type setting, or

use paper type with a smoother surface.
• Ensure that the humidity in the room is within specifica-

tions. For details, refer to Relative Humidity.
• For details, refer to Selecting a Location for the Printer.

Random spots on the output, or
the image is blurry.

Turn off the printer, then turn it on again.
If the error persists, contact your Xerox representative.

The output is blank.
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SolutionsSymptom

Replace the Smart Kit Drum Cartridge.
Contact your Xerox representative.

Streaks appear in the output.

• Verify that the paper is the correct size, type, and weight.
If not, change the paper settings.

• Ensure that the humidity is within specifications. For de-
tails, refer to Selecting a Location for the Printer.

The output has a mottled ap-
pearance.

• Verify that the paper is the correct size, type, and weight.
If not, change the paper settings.

• Change the Paper Type settings in the print driver.
• In the Printing Preferences of the print driver, on the Pa-

per/Output tab, change the Paper Type setting.
• Replace the Drum Cartridge.

Ghosting appears in the printed
output.

• To check the toner level, check the control panel, use the
print driver, or CentreWare Internet Services. If the toner
cartridge is near empty, replace it.

• Verify that the toner cartridge is approved for use in this
printer, and replace it as needed. For best results, use a
genuine Xerox toner cartridge.

• Replace the Drum Cartridge.

Auger marks appear on the
printed output.
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SolutionsSymptom

• Verify that the paper is the correct size, type, and weight
for the printer and that it is loaded properly. If not, change
the paper.

• Try a new ream of paper.
• Change the Paper Type settings in the print driver.
• In the Printing Preferences of the print driver, on the Pa-

per/Output tab, change the Paper Type setting.

The output print is wrinkled or
stained.

• Verify that envelopes are loaded properly in the bypass
tray.

• Follow the guidelines for printing on envelopes. For details,
refer to Guidelines for Printing Envelopes.

Envelopes are wrinkled or
creased when printed.

• Verify that the paper is loaded properly.
• Verify that the margins are set correctly in the application

you are using.

The top margin is incorrect.

1. Print a solid image over the entire surface of one sheet
of paper.

2. Load the printed sheet into the tray with the printed side
face down.

3. Print five blank pages to remove debris from the fuser
rollers.

The printed surface of the paper
is bumpy.
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Getting Help
Xerox provides several automatic diagnostic utilities to help you maintain productivity
and print quality.

Control Panel Messages

The printer control panel provides information and troubleshooting help. When a fault
or warning condition occurs, the control panel displays a message informing you of the
problem.

Available Information Pages

Information pages provide important details to help you troubleshoot issues or analyze
printer use. You can print information pages from the printer control panel.

DescriptionInformation Page

The Configuration Report provides product information including,
installed options, network settings, port setup, tray information, and
more.

Configuration Report

Shows information/life remaining status on Routing Maintenance
Items.

Supplies Usage Page

Lists Device information, Billing Meter information, and more.Usage Profile

List of installed internal fonts on printer.PostScript Font List

PCL Font List

One touch to print all of the available Information pages.Print All Above Reports

For information on how to print information pages, refer to Information Pages.

Accessing Available Information Pages
To access the Information Pages:
1. At the printer, press theMenu button.
2. Press the Down arrow button, and select Information.
3. Press the Right arrow button.
4. Press the Down arrow button, and select Information Pages.
5. Press the Right arrow button.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and
troubleshooting help to solve your printer problems. You can find solutions for
print-quality problems, paper jams, software installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/3330support.
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More Information

You can obtain more information about your printer from these sources:

LocationResource

Packaged with the printer.Installation Guide

www.xerox.com/office/3330docsOther documentation for your printer

www.xerox.com/office/3330supportTechnical support information for your printer;
including online technical support, Online Sup-
port Assistant, and driver downloads.

www.xerox.com/office/3330suppliesOrder supplies for your printer

www.xerox.com/office/businessresourcecenterA resource for tools and information, including
interactive tutorials, printing templates, helpful
tips, and customized features to meet your in-
dividual needs.

www.xerox.com/office/worldcontactsLocal sales and support center

www.xerox.com/office/registerPrinter registration

www.direct.xerox.com/Xerox® Direct online store
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A
Specifications

Printer Configurations and Options

Configurations

The WorkCentre® 3330 is a network printer and includes the following:

• Print
• 50-sheet bypass tray
• Tray 1 with 250-sheet capacity
• Optional Tray 2 with 550-sheet capacity

Standard Features

Standard mode supports up to 42 ppm LetterPrint speed

Standard mode supports up to 21 ppm for Letter and 20 ppm
for A4.

2-Sided print speed

• Standard print-quality mode: 600 x 600dpi
• Enhanced print-quality mode: 1200 x 1200 dpi

Print resolution

512 MBStandard Memory (DRAM)

128 MBFlash Memory (ROM)

• Bypass tray: 50-sheets
• Tray 1: 250-sheets
• Optional Tray 2: 550-sheets

Paper capacity (80 g/20 lb.)

Legal (216 x 356 mm, 8.5 x 14 in.)Maximum print size

Standard2-Sided Printing
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Display and keypad navigationControl panel

• Universal Serial Bus (USB 2.0)
• USB Flash drive
• Ethernet 10/100/1000 Base-T
• Wireless
• WiFi

Connectivity

Physical Specifications

Weights and Dimensions

Standard Configuration with Tray 1
and Optional Tray 2

Standard Configuration with Tray 1
only

37 cm (14.5 in.)37 cm (14.5 in.)Width

45.5 cm (17.9 in.)37 cm (14.5 in.)Depth

43.4 cm (17.1 in.)29 cm (11.4 in.)Height

14.9 kg (32.1 lb.)12.7 kg (28.0 lb.)Weight

Clearance Requirements for Standard Configuration
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Environmental Specifications

Temperature
• Operating Temperature: 0–50°C (32–122°F)
• Storage Temperature: -25–85°C (-13–185°F)

Relative Humidity

Minimum–Maximum Humidity Range: 10–90%, less than 90% when in the packaging

• Optimum Humidity: 30–70%
• Operating Humidity: 20–80% Relative Humidity

Note
Under extreme environmental conditions, defects can occur due to condensation.

Elevation

For optimum performance, use the printer at elevations below 2500 m (8,202 ft.).

Electrical Specifications

Power Supply Voltage and Frequency

Power Supply FrequencyPower Supply Voltage

50 Hz
60 Hz

110–127 VAC +/-10%, (99–135 VAC)

50 Hz
60 Hz

220–240 VAC +/-10%, (198–264 VAC)

Power Consumption
• Energy Saver Mode (Sleep): Maximum 3.5 W
• Continuous printing: Maximum 700 W
• Ready/Standby: Maximum 50 W

This printer does not consume electric power when the power switch is turned off even
if the printer is connected to an AC outlet.
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Performance Specifications

Printer Warm-up Time

Less than 55 seconds from sleep mode.

Print Speed

Maximum print speeds for 1-sided continuous printing are 42 ppm for Letter (8.5 x 11
in.) and 40 ppm for A4 (210 x 297 mm).

Several factors affect print speed:

• 2-sided printing: The maximum print speeds for 2-sided continuous printing are 21
ppm for Letter (8.5 x 11 in.) and 20 ppm for A4 (210 x 297 mm).

• Print mode: Standard is the fastest print mode. Enhanced is half speed, or slower.
• Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print

speed.
• Paper type: Plain paper prints faster than Cardstock or Heavyweight.
• Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and

Labels.
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B
Regulatory Information

Basic Regulations
Xerox has tested this printer to electromagnetic emission and immunity standards. These
standards are designed to mitigate interference caused or received by this printer in a
typical office environment.

ENERGY STAR® Qualified Product
The Phaser® 3330 is ENERGY STAR® qualified under the ENERGY STAR Program
Requirements for Imaging Equipment.
The ENERGYSTARand ENERGYSTARmark are registeredUnited States trademarks.
The ENERGY STAR Imaging Equipment Program is a team effort between the
United States, European Union, and Japanese governments and the office equip-
ment industry to promote energy-efficient copiers, printers, fax, multifunction
printers, personal computers, andmonitors. Reducing product energy consumption
helps combat smog, acid rain, and long-term changes to the climate by decreasing
the emissions that result from generating electricity.
Xerox ENERGY STAR equipment is preset at the factory. Your printer is delivered
with the timer, for switching to Power Saver Mode from the last copy/print out, set
at 1 or 2 minutes. A more detailed description of this feature can be found in the
Power Saver section of this guide.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy. If it is not installed and used in accordance with these instructions,
itmay cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his/her own expense.
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If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Changes ormodifications to this equipment not approved by Xerox can void the authority
of the user to operate this equipment.

Note
To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

European Union
The CE mark applied to this product symbolizes a declaration of conformity by
Xerox with the following applicable Directives of the European Union as of the
dates indicated:

• February 26, 2014: Low Voltage Directive 2014/35/EU
• February 26, 2014: Electromagnetic Compatibility Directive 2014/30/EU
• March 9, 1999: Radio & Telecommunications Terminal Equipment Directive

1999/5/EC

This printer, if used properly in accordance with the instructions, is not dangerous for
the consumer or for the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this printer can be obtained from
Xerox.

European Union Lot 4 Imaging Equipment Agreement
Environmental Information
Environmental Information Providing Environmental Solutions and
Reducing Cost

The following information has been developed to assist users and has been issued in
relation to the European Union (EU) Energy Related Products Directive, specifically the
Lot 4 study on Imaging Equipment. This requiresmanufacturers to improve environmental
performance of in scope products and supports the EU action plan on energy efficiency.
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In scope products are Household and Office equipment that meet the following criteria.

• Standard monochrome format products with a maximum speed less than 66 A4
images per minute

• Standard color format products with a maximum speed less than 51 A4 images per
minute

Introduction

The following information has been developed to assist users and has been issued in
relation to the European Union (EU) Energy Related Products Directive, specifically the
Lot 4 study on Imaging Equipment. This requiresmanufacturers to improve environmental
performance of in scope products and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.

• Standard monochrome format products with a maximum speed less than 66 A4
images per minute

• Standard color format products with a maximum speed less than 51 A4 images per
minute

Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability.
This enables you to print on both sides of the paper automatically, and therefore helps
to reduce the use of valuable resources by reducing your paper consumption. The Lot 4
Imaging Equipment agreement requires that onmodels greater than or equal to 40 ppm
color or greater than or equal to 45 ppm monochrome the duplex function has been
auto enabled, during the setup and driver installation. Some Xerox models below these
speed bands may also be enabled with 2-sided printing settings defaulted on at the
time of install. Continuing to use the duplex function will reduce the environmental
impact of your work. However, should you require simplex/1-sided printing, you may
change the print settings in the print driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an
environmental stewardship scheme, which complies with EN12281 or a similar quality
standard. Lighter weight paper (60 g/m²), which contains less raw material and thus
save resources per print, may be used in certain applications.We encourage you to check
if this is suitable for your printing needs.

ENERGY STAR (European Union Information)

The ENERGY STAR program is a voluntary scheme to promote the development and
purchase of energy efficientmodels, which help to reduce environmental impact. Details
on the ENERGY STAR program and models qualified to ENERGY STAR can be found at
the following website: www.energystar.gov/find_a_product
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Power Consumption and Activation Time

The amount of electricity a product consumes depends on the way the device is used.
This product is designed and configured to enable you to reduce your electricity costs.
After the last print, the device switches to Ready mode. In this mode, the device can
print again immediately. If the product is not used for a period of time, the device
switches to a Power Saver mode. In these modes, to enable reduced product power
consumption, only essential functions remain active.

The product takes slightly longer to produce the first print after it exits Power Saver
mode than it takes in Readymode. This delay is the result of the systemwaking up from
Power Saver mode and is typical of most imaging products on the market.

You can set a longer activation time or completely deactivate the Power Saver mode.
This device can take longer to switch to a lower energy level.

To learn more about Xerox participation in sustainability initiatives, go to:
www.xerox.com/about-xerox/environment/enus.html .

Environmental Choice Certified to Office Machines CCD-035

This product is certified to Environmental Choice standard for office ma-
chines, meeting all requirements for reduced environmental impact. As part
of achieving certification, Xerox Corporation has proven this product meets
the Environmental Choice criteria for energy efficiency. Certified copier,
printer, multifunctional device, and fax productsmust alsomeet criteria such
as reduced chemical emissions and demonstrate compatibility with recycled
supplies. Environmental Choice was established in 1988 to help consumers
find products and serviceswith reduced environmental impacts. Environment-
al Choice is a voluntary, multi-attribute, and lifecycle-based environmental
certification. This certification indicates that a product has undergone rigor-
ous scientific testing, exhaustive auditing, or both, to prove its compliance
with stringent, third-party, environmental performance standards.

Germany
Germany - Blue Angel

RAL, the German Institute for Quality Assurance and Labeling, has awarded
this device the Blue Angel Environmental Label. This label distinguishes it
as a device that satisfies Blue Angel criteria for environmental acceptability
in terms of device design,manufacture, and operation. Formore information,
go to: www.blauer-engel.de .

Blendschutz

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am
Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen amBildschirmarbeitsplatz
zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.

Xerox® Phaser® 3330 PrinterB-4
User Guide

Regulatory Information

http://www.xerox.com/about-xerox/environment/enus.html
http://www.blauer-engel.de


Lärmemission

Maschinenlärminformations-Verordnung3. GPSGV:Der höchste Schalldruckpegel beträgt
70 dB(A) oder weniger gemäß EN ISO 7779.

Importeur

Xerox GmbH

Hellersbergstraße 2-4

41460 Neuss

Deutschland

Turkey RoHS Regulation

In compliance with Article 7 (d), we hereby certify “it is in compliance with the
EEEregulation.”

“EEE yönetmeliğine uygundur.”

Regulatory Information for 2.4 GHz Wireless Network Adapter

This product contains a 2.4-GHz Wireless LAN radio transmitter module which complies
with the requirements specified in FCC Part 15, Industry Canada RSS-210 and European
Council Directive 99/5/EC.

Operation of this device is subject to the following two conditions: (1) this device may
not cause harmful interference, and (2) this devicemust accept any interference received,
including interference that may cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox
Corporation may void the user's authority to operate this equipment.

Material Safety Data Sheets
For Material Safety Data information regarding your printer, go to:

• North America: www.xerox.com/msds
• European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to
www.xerox.com/office/worldcontacts.
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C
Recycling and Disposal

All Countries
If you are managing the disposal of your Xerox product, please note that the printer
may contain lead, mercury, perchlorate, and other materials whose disposal may be
regulated due to environmental considerations. The presence of these materials is fully
consistent with global regulations applicable at the time that the product was placed
on the market. For recycling and disposal information, contact your local authorities.
Perchlorate Material: This product may contain one or more Perchlorate-containing
devices, such as batteries. Special handling may apply, please see
www.dtsc.ca.gov/hazardouswaste/perchlorate.

North America
Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox
representative (1-800-ASK-XEROX) to determine if this Xerox product is part of the
program. For more information about Xerox environmental programs, visit
www.xerox.com/environment, or for recycling and disposal information, contact your
local authorities.

European Union
Some equipmentmay be used in both a domestic/household and a professional/business
application.

Domestic/Household Environment
Application of this symbol on your equipment is confirmation that you should
not dispose of the equipment in the normal household waste stream.
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In accordance with European legislation, end-of-life electrical and electronic equipment
subject to disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic
equipment to designated collection facilities free of charge. Please contact your local
disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be
required to take back your old equipment free of charge. Please ask your retailer for
information.

Professional/Business Environment
Application of this symbol on your equipment is confirmation that you must
dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end-of-life electrical and electronic equipment
subject to disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end-of-life
take-back information.

Collection and Disposal of Equipment and Batteries

• These symbols on the products and/or accompanying documents mean
that used electrical and electronic products and batteries should not be
mixed with general household waste.

• For proper treatment, recovery, and recycling of old products and used
batteries, please take them to applicable collection points, in accordance
with your national legislation and theDirective 2002/96/ECand2006/66/EC.

• By disposing of these products and batteries correctly, you will help to save
valuable resources and prevent any potential negative effects on human
health and the environmentwhich could otherwise arise from inappropriate
waste handling.

• For more information about collection and recycling of old products and
batteries, please contact your localmunicipality, your waste disposal service,
or the point of sale where you purchased the items.

• Penaltiesmay be applicable for incorrect disposal of this waste, in accordance
with national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or
supplier for further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items,
please contact your local authorities or dealer and ask for the correctmethod of disposal.
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Battery Symbol Note
This wheeled-bin symbol may be used in combination with a chemical symbol.
This establishes compliance with the requirements set out by the Directive.

Battery Removal

Batteries should only be replaced by a manufacturer-approved service facility.

Other Countries
Please contact your local waste management authority to request disposal guidance.
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